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1. ИНФОРМАЦИЯ О ПРОДУКТЕ 

 

1.1 Описание продукта 

 

COrDIS «ЭКСПЕРТ 26» – набор реагентов для молекулярно-

генетической идентификации личности на основе мультиплексного ПЦР-анализа 

26-ти высоко полиморфных локусов геномной ДНК человека: AMEL, SRY, 

D3S1358, TH01, D12S391, D5S818, TPOX, Yindel, D2S441, D7S820, D13S317, 

FGA, D22S1045, D18S51, D16S539, D8S1179, CSF1PO, D6S1043, vWA, D21S11, 

SE33, D10S1248, D1S1656, D19S433, D2S1338, DYS391.  

 Анализ результатов ПЦР проводится методом капиллярного 

электрофореза с использованием автоматических генетических анализаторов с 

лазериндуцированной флуоресцентной детекцией. В наборе используется пять 

флуоресцентных красителей, характеризующихся разными длинами волн 

эмиссии для возможности одновременной детекции в разных каналах 

флуоресценции. Праймеры мечены пятью флуоресцентными красителями, 

детектируемыми в каналах Blue, Green, Yellow, Red, Purple. Стандарт длины S550 

мечен шестым флуоресцентным красителем и детектируется в отдельном канале 

Orange одновременно с продуктами ПЦР. 

Для получения полного STR-профиля образца достаточно 0.1 нанограмм 

недеградированной ДНК. При этом набор реагентов COrDIS «ЭКСПЕРТ 26» 

позволяет амплифицировать генетический материал в широком динамическом 

диапазоне концентраций ДНК. Данный эффект достигается благодаря 

уникальной технологии нормирования сигнала целевого продукта реакции 

амплификации (технология нормирующей амплификации COrDIS STRICT). 

Исследование препаратов ДНК может проводиться без предварительной оценки 

и нормирования концентрации ДНК. Вне зависимости от количества исходной 

ДНК, вносимой в реакцию, финальное количество целевых ПЦР продуктов всегда 

5.1 Спектральная калибровка ______________________________________________ 22 
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находится на одном и том же уровне (оптимальном для проведения дальнейшего 

электрофоретического исследования). 

Общий объем реакции составляет 25 мкл. При работе с препаратами 

ДНК, полученными из образцов сравнения и содержащими заведомо достаточное 

для исследования количество генетического материала (например, при работе с 

препаратами ДНК, полученными из образцов буккального эпителия) ПЦР 

реакция может проводиться в объеме 10 мкл. Не рекомендуется снижать объем 

реакции в случае анализа низкокопийных препаратов ДНК, препаратов ДНК 

содержащих ингибиторы ПЦР, а также препаратов, содержащих 

деградированный генетический материал.  

Максимальный объем вносимого в реакцию раствора ДНК может 

составлять 15 мкл при общем объеме реакции 25 мкл. В случае проведения 

реакции амплификации в объеме 10 мкл максимальный объем вносимого в 

реакцию раствора ДНК может составлять 6 мкл. 

Набор COrDIS «ЭКСПЕРТ 26» может использоваться для создания 

национальных криминалистических баз данных в странах, использующих в 

качестве стандартной панели локусов маркеры CODIS (Combined DNA Index 

System), EXPANDED CODIS (Expanded Combined DNA Index System) а также 

Европейских баз данных на основе ESS (European standard set), включая страны, 

использующие SE33 как обязательный маркер. Набор COrDIS «ЭКСПЕРТ 26» 

прекрасно подходит для ДНК-идентификации личности, анализа родства 

(например, экспертизы спорного отцовства), а также для анализа химеризма 

после пересадки костного мозга. 

Набор валидирован для проведения ПЦР в амплификаторах: GeneAmp® 

9700, GeneAmp® 2720, ProFlex PCR System , SimpliAmp™ Thermal Cycler, 

Veriti™ 96-Well Thermal Cycler.  

Анализ ПЦР-продуктов может проводиться с использованием 

генетических анализаторов ABI PRISM® 3130/3130XL/3500/3500XL (Applied 

Biosystems), Нанофор 05 (СИНТОЛ). 
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Таблица 1. Описание STR-локусов COrDIS «ЭКСПЕРТ 26»  

 
Маркер Реф. номер Реф. аллель Хромосомная Структура единицы 

 GenBank® GenBank® локализация повтора реф. аллеля  

 

D1S1656 NC_000001.9 17 1q42 [TAGA]16 [TGA][TAGA][TAGG]1[TG]5 

D2S441 AL079112 12 2p14 [TCTA]12 
D3S1358 NT_005997 18 3p21.31 TCTA [TCTG]2 [TCTA]15 

D5S818 AC008512 11 5q23.2 [AGAT]11 

D7S820 AC004848 13 7q21.11 [GATA]13 
D8S1179 AF216671 13 8q24.13 [TCTA]3 

D10S1248 AL391869 13 10q26.3 [GGAA]13 

D12S391 G08921 19.3 12p13.2 [AGAT]5 GAT[AGAT]7 [AGAC]6 

    AGAT 

D13S317 AL353628 11 13q31.1 [TATC]11 

D16S539 AC024591 11 16q24.1 [GATA]11 
D18S51 AP001534 18 18q21.33 [AGAA]18 

D21S11 AP000433 29 21q21.1 [TCTA]4[TCTG]6 

    [TCTA]3TA[TCTA]3 

    TCA [TCTA]2TCCATA [TCTA]11 

D22S1045 AL022314 17 22q12.3 [ATT]14 ACT [ATT]2 

CSF1PO X14720 12 5q33.1 [AGAT]12 
FGA M64982 21 4q31.3 [TTTC]3 TTTTTTCT[CTTT]13 

    CTCC[TTCC]2 

SE33 V00481 26.2 6q14 [AAAG]8 AA [AAAG]17 
TH01 D00269 9 11p15.5 [TCAT]9 

TPOX M68651 11 2p25.3 [AATG]11 

VWA M25858 18 12p13.31 TCTA [TCTG]4 [TCTA]13 

D6S1043 NT_007299 12 6q15 [AGAT]9-25 

D19S433 AC008507.6 14 19q12 (AAGG)(AAAG)(AAGG)(TAGG) 

    [AAGG]n  
D2S1338 AC010136 23 2q35 [TGCC]n[TTCC]n 

DYS391 AC011302 11 Y [TCTA]n 

Аmel X  M55418 X Xp22.1-22.3 
Аmel Y  M55419 Y Yp11.2 

SRY MH972533 SRY Yp11.2 

Yindel M175 2 Yq11.221  
  

 

Таблица 1 Сводная информация о локусах ДНК, присутствующих в составе набора 

COrDIS «ЭКСПЕРТ 26». Для STR-локусов структура единицы повтора приводится в 

соответствии с рекомендациями Международного Общества Судебных Генетиков 

(International Society for Forensic Genetics - ISFG) [Bär et al, 1997].  
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1.2 Компоненты набора и состав 

 
Набор реагентов Эксперт 26, 200 реакций (каталожный номер Е26-200)  

 
1. Пробирка с реакционной смесью  1 пробирка (1 мл)  

2. Раствор активатора   1 пробирка (1 мл) 

3. Деионизированная вода   1 пробирка (1.7 мл) 

4. Контрольная ДНК MK01   1 пробирка (0.1 нг/мкл) 

5. Стандарт длины S550    2 пробирки (по 120 нанесений) 

6. Аллельная лестница    1 пробирка (50 нанесений) 

 

Набор реагентов Эксперт 26, 1000 реакций (каталожный номер Е26-1000) 

 
1. Пробирка с реакционной смесью  5 пробирок (1 мл)  

2. Раствор активатора   5 пробирок (1 мл) 

3. Деионизированная вода   5 пробирок (1.7 мл) 

4. Контрольная ДНК MK01   1 пробирка (0.1 нг/мкл) 

5. Стандарт длины S550   10 пробирок (по 120 нанесений) 

6. Аллельная лестница   2 пробирки (50 нанесений) 

 

 

Реакционная смесь представляет собой раствор, содержащий компоненты 

полимеразной цепной реакции включая Taq-полимеразу, смесь дНТФ, 

реакционный буфер, праймерную смесь. 

Раствор активатора используется для активации реакционной смеси. 

Содержит буферный раствор и ионы магния Mg2+ в качестве активатора 

полимеразной цепной реакции. 

Деионизированная вода предназначена для доведения реакций до рабочего 

объема. 

Контрольная ДНК МК01 представляет собой 10 нг высокомолекулярной 

геномной ДНК мужчины в концентрации 0.1 нг/мкл с известным генотипом по 

всем исследуемым локусам (стр. 38, рис. 2). Предназначена для контроля этапов 

амплификации, электрофореза и анализа данных. 

Стандарт длины S550 представляет собой лиофилизированную смесь 

флуоресцентно-меченных фрагментов ДНК разной длины, меченых 

спектральным аналогом LIZ, детектируемым в канале Orange. Стандарт длины 

S550 содержит 26 фрагментов ДНК разной длины (н.п.): 60, 70, 80, 90, 100, 120, 

140, 160, 180, 200, 220, 230, 240, 260, 280, 300, 320, 340, 360, 380, 400, 420, 440, 

450, 500, 550. Стандарт S550 используется на этапе капиллярного электрофореза, 

вносится в каждый капилляр одновременно с исследуемым образцом и служит 

опорным внутренним стандартом для построения кривой подвижности 

амплифицированных фрагментов исследуемого образца. Благодаря высокой 

плотности фрагментов стандарта S550 обеспечивается высокая точность и 

воспроизводимость определения длины амплифицированных фрагментов 

исследуемого образца. Перед использованием требует добавления воды (п. 2.1). 
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Аллельная лестница представляет собой лиофилизированную смесь из 

флуоресцентно-меченных амплифицированных фрагментов ДНК, 

соответствующих всем аллельным вариантам исследуемых локусов, 

встречающимся с частотой более 1%. Аллельная лестница используется на этапе 

капиллярного электрофореза, анализируется параллельно с каждой серией 

образцов для идентификации аллельных вариантов исследуемых локусов. 

Аллельная лестница содержит ПЦР-продукты и при несоблюдении мер 

предосторожности может быть источником контаминации остальных реагентов. 

Поставляется в лиофилизированном виде. Перед использованием требует 

добавления воды (п. 2.2). 

 
1.3 Условия хранения 

 

Компоненты набора необходимо хранить при температуре от -15°C до  

-25°C. После начала использования допускается хранение при 

температуре от +2°C до +8°C в течение 1 месяца. Длительное хранение 

компонентов набора рекомендовано при температуре от -15°C до  

-25°C. В соответствии с действующими Техническими Условиями допускается 

режим транспортировки при температуре не выше +25°C в течении 14 

календарных дней.  

 

 

1.4 Основные характеристики набора 

 

Количество одновременно анализируемых маркеров – 26; 

Список одновременно анализируемых локусов:  

AMEL, SRY, D3S1358, TH01, D12S391, D5S818, TPOX, Yindel, D2S441, D7S820, 

D13S317, FGA, D22S1045, D18S51, D16S539, D8S1179, CSF1PO, D6S1043, vWA, 

D21S11, SE33, D10S1248, D1S1656, D19S433, D2S1338, DYS391 

Количество флуоресцентных меток, используемых в наборе – 6 

Оптимальное количество вносимой ДНК (в реакцию): 0.2–200 нг 

Предел чувствительности: 0.1 нг (в реакцию) 

Функциональные характеристики набора COrDIS «ЭКСПЕРТ 26» 

определены на основании результатов валидационных исследований наборов 

реагентов согласно международным рекомендациям SWGDAM.  

 

1.5 Гарантии качества 

 

Качество каждого компонента набора проверено и контролируется в 

процессе производства. Каждый выпущенный лот реагентов регулярно 

проверяется на соответствие заявленным характеристикам в течение 18 месяцев. 

В случае возникновения вопросов относительно качества набора COrDIS 

«ЭКСПЕРТ 26», просим незамедлительно связаться с ООО “ГОРДИЗ”. 
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1.6 Сопутствующие материалы 

 

Необходимые материалы, не входящие в набор: 

 

Матриксный стандарт CS6 (ООО “ГОРДИЗ”) 

 

Бины и панели для GeneMapperTM (ООО “ГОРДИЗ”, предоставляются бесплатно 

по запросу).  

 

Материалы, поставляемые другими производителями: 

 
Реагент    Производитель  Каталожный номер 

10-кратный буфер «ТАПС»  ООО «НПФ Синтол» ПД-0407 

Полимер «ПДМА-4»  ООО «НПФ Синтол» БТС-0050 

Hi-DiTM Formamide  Applied Biosystems (P/N 4311320) 

10 x Genetic Analyzer Buffer Applied Biosystems (P/N 402824) 

Polymer (POP-4)   Applied Biosystems (P/N 402838)  
 

 

2.  РАЗВЕДЕНИЕ СУХИХ КОМПОНЕНТОВ 

 

2.1 Размерный стандарт S550 

 
Сразу после получения набора необходимо извлечь комплект для 

электрофореза и хранить отдельно в зоне для работы с ПЦР продуктами в 

темном месте при температуре +2– +8 °C.  

Перед использованием добавить 120 мкл деионизированной воды в 

пробирку с сухим размерным стандартом S550. Тщательно перемешать на 

вортексе и собрать на дне пробирки коротким центрифугированием. После 

разведения готовый раствор допускается хранить при температуре +2– +8 °C в 

течение месяца. Длительное хранение готового раствора рекомендовано при 

температуре от -15°C до -25°C. Для проведения капиллярного электрофореза 

добавить 1 мкл стандарта S550 в каждую лунку планшета, содержащую 

формамид и ПЦР продукт. 

Объем вносимого в лунку размерного стандарта S550 может быть снижен 

до 0.3 мкл для увеличения возможного количества инжекций. При этом для 

оптимизации уровня сигнала рекомендуется использовать 1 мкл стандарта S550 

для каждого исследуемого препарата. Дополнительный размерный стандарт S550 

может быть заказан по каталожному номеру S550-10. 
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2.2  Аллельная лестница 

 
Сразу после получения набора, пробирку с аллельным лэддером 

необходимо извлечь из коробки и хранить отдельно в зоне для работы с 

ПЦР продуктами в темном месте. Для получения рабочего раствора добавить в 

пробирку с сухим аллельным лэддером 50 мкл деионизированной воды, 

поставляемой с набором. Тщательно перемешать на вортексе и собрать на дне 

пробирки центрифугированием в течение нескольких секунд. После разведения 

готовый раствор допускается хранить при температуре +2– +8 °C в течение 

месяца. Длительное хранение готового раствора рекомендовано при 

температуре от -15°C до -25°C. Для проведения капиллярного электрофореза 

необходимо добавить 1 мкл лэддера в смесь формамида и размерного стандарта. 

При недостаточной чувствительности генетического анализатора допускается 

увеличение объема вносимой в лунку аллельной лестницы до 2 мкл. 

 

3. СТАНДАРТНЫЕ ПРОТОКОЛЫ АМПЛИФИКАЦИИ 

 
3.1 Постановка реакции в 25 мкл 

 
Набор реагентов COrDIS «ЭКСПЕРТ 26» позволяет проводить 

амплификацию в широком диапазоне значений концентрации исследуемых 

препаратов. Так как в норме концентрация препаратов ДНК редко превышает 200 

нг/мкл, предварительное определение точного значения концентрации ДНК в 

исследуемых препаратах не требуется. 

В каждую пробирку необходимо внести 5 мкл Реакционной смеси, 5 мкл 

Активатора. Затем внести до 15 мкл раствора исследуемой геномной ДНК в 

количестве 0.2–200 нг. При необходимости общий объем реакции довести до 25 

мкл деионизированной водой, поставляемой в составе набора.  

 

 
Компоненты набора Объем на 1 реакцию 

Реакционная смесь      5 мкл 

Раствор Активатора       5 мкл 

Геномная ДНК (0.2–200 нг)                 до 15 мкл 

Деионизированная вода, до конечного объема 25 мкл  

 

После внесения всех компонентов, реакционную смесь необходимо 

тщательно перемешать до гомогенного состояния 5–8 кратным пипетированием, 

либо используя вортекс. При необходимости собрать раствор на дне пробирки 

коротким центрифугированием. Тщательное перемешивание необходимо для 

максимальной эффективности реакции. 

С каждой серией исследуемых образцов необходимо амплифицировать 

один положительный контроль (15 мкл контрольной ДНК, поставляемой с 

набором) и один отрицательный контроль (15 мкл деионизированной воды 

вместо ДНК). 
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3.2 Постановка реакции в 10 мкл 

 
Протокол предназначен для работы с высококонцентрированными 

препаратами ДНК, содержащими заведомо пригодный для исследования 

генетический материал человека (например, препаратами ДНК, полученными из 

образцов буккального эпителия или иных образцов сравнения). Не рекомендуется 

снижать объем реакции в случае анализа низкокопийных препаратов ДНК, 

препаратов ДНК содержащих ингибиторы ПЦР, а также препаратов, содержащих 

деградированный генетический материал.  

 

В каждую пробирку необходимо внести 2 мкл Реакционной смеси, 2 мкл 

Активатора. Затем внести до 6 мкл раствора исследуемой геномной ДНК в 

количестве 0.2–200 нг. 

 
Компоненты набора Объем на 1 реакцию 

Реакционная смесь      2 мкл 

Раствор Активатора       2 мкл 

Геномная ДНК (0.2–200 нг)              до  6 мкл  

Деионизированная вода, до конечного объема 10 мкл 

 

После внесения всех компонентов, реакционную смесь необходимо 

тщательно перемешать до гомогенного состояния 5–8  кратным пипетированием, 

либо используя вортекс. При необходимости собрать раствор на дне пробирки 

коротким центрифугированием. Тщательное перемешивание необходимо для 

максимальной эффективности реакции. 

С каждой серией исследуемых образцов необходимо амплифицировать 

один положительный контроль (6 мкл контрольной ДНК, поставляемой с 

набором) и один отрицательный контроль (6 мкл деионизированной воды 

вместо ДНК). 

 

3.3 Постановка реакции с материалом на картах-носителях в 25 мкл 

 
Набор реагентов COrDIS «ЭКСПЕРТ 26» позволяет проводить 

амплификацию материала с карт-носителей (например FTA). 

При исследовании биоматериала на целлюлозных картах-носителях в 

каждую пробирку необходимо внести 5 мкл Реакционной смеси, 5 мкл 

Активатора и 15 мкл деионизированной воды, поставляемой в составе набора. 

Затем внести в пробирку исследуемый образец. Оптимальный диаметр вносимого 

предмета-носителя (панч карты) составляет 1.2 мм. Оптимальное количество 

вносимого материала зависит от структуры материала носителя и особенностей, 

собираемых на носитель образцов. 
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Компоненты набора Объем на 1 реакцию 

Реакционная смесь      5 мкл 

Раствор Активатора       5 мкл 

Деионизированная вода, до конечного объема 15 мкл  

 

После внесения всех компонентов, реакционную смесь необходимо 

тщательно перемешать до гомогенного состояния 5–8  кратным пипетированием, 

либо используя вортекс. При необходимости собрать раствор на дне пробирки 

коротким центрифугированием. Тщательное перемешивание необходимо для 

максимальной эффективности реакции. 

С каждой серией исследуемых образцов необходимо амплифицировать 

один положительный контроль (15 мкл контрольной ДНК, поставляемой с 

набором) и один отрицательный контроль (15 мкл деионизированной воды 

вместо ДНК). 

 

 

3.4 Постановка реакции с материалом на картах-носителях в 10 мкл 

 

При исследовании биоматериала на целлюлозных картах-носителях в 

каждую пробирку необходимо внести 2 мкл Реакционной смеси, 2 мкл 

Активатора и 6 мкл деионизированной воды, поставляемой в составе набора. 

Затем внести в пробирку исследуемый образец. Оптимальный диаметр вносимого 

предмета-носителя (панч карты) составляет 1.2 мм. Оптимальное количество 

вносимого материала зависит от структуры материала носителя и особенностей, 

собираемых на носитель образцов. 

 

 
Компоненты набора Объем на 1 реакцию 

Реакционная смесь      2 мкл 

Раствор Активатора       2 мкл 

Деионизированная вода, до конечного объема _6 мкл__ 

 

 

После внесения всех компонентов реакционную смесь необходимо 

тщательно перемешать до гомогенного состояния 5–8  кратным пипетированием, 

либо используя вортекс. При необходимости собрать раствор на дне пробирки 

коротким центрифугированием. Тщательное перемешивание необходимо для 

максимальной эффективности реакции. 

С каждой серией исследуемых образцов необходимо амплифицировать 

один положительный контроль (6 мкл контрольной ДНК, поставляемой с 

набором) и один отрицательный контроль (6 мкл деионизированной воды 

вместо ДНК). 

 

 



COrDIS «ЭКСПЕРТ 26»                  Инструкция пользователя        231110 

- 11 - 

 

 

 

3.5 Постановка реакции с образцами цельной крови 

 
Протокол предназначен для работы с образцами цельной крови 

(необходимо учесть, что забор образцов цельной крови должен производиться в 

пробирку с ЭДТА). 

Для постановки реакции с образцами цельной крови необходимо 

подготовить разведения образцов крови в стандартном буфере TE по схеме:  
 

Подготовка препаратов крови                

Цельная кровь   2 мкл 

Стандартный буфер TE     60 мкл 

  

В каждую пробирку необходимо внести 2 мкл Реакционной смеси, 2 мкл 

Активатора. Затем внести 6 мкл предварительно подготовленных препаратов 

крови. 

 
Компоненты набора Объем на 1 реакцию 

Реакционная смесь      2 мкл 

Раствор Активатора       2 мкл 

Подготовленный препарат крови                 6 мкл  

Конечный объем реакции    10 мкл 

 

 

После внесения всех компонентов, реакционную смесь необходимо 

тщательно перемешать до гомогенного состояния 5–8 кратным пипетированием, 

либо используя вортекс. При необходимости собрать раствор на дне пробирки 

коротким центрифугированием. Тщательное перемешивание необходимо для 

максимальной эффективности реакции. 

С каждой серией исследуемых образцов необходимо амплифицировать 

один положительный контроль (6 мкл контрольной ДНК, поставляемой с 

набором) и один отрицательный контроль (6 мкл деионизированной воды 

вместо крови). 
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3.6 Стандартная программа амплификации 

 

Приведенные ниже условия амплификации рекомендуются в качестве 

стандартных и применимы при работе по стандартному протоколу. Изменение 

количества циклов амплификации недопустимо. 

  

Параметры ПЦР: 

____________________________ 

94°C 2 мин 

 

96°C 5 сек 

60°C 30 сек   28 циклов 

72°C 30 сек 

 

96°C 5 сек 

62°C 30 сек   5 циклов 

72°C 30 сек 

 

68°C 15 мин 

 

15°C  ∞ 

 

После завершения программы амплификации ПЦР продукты можно 

хранить неделю при 4°C – 8°C в защищенном от света месте. В случае, если 

амплифицированные продукты необходимо хранить более недели, 

рекомендуется заморозка при -20°C.  
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4. ЭЛЕКТРОФОРЕЗ НА АНАЛИЗАТОРЕ ABI PRISM 3500/3500XL 

 

При работе с генетическим анализатором ABI PRISM и последующем 

анализе флуоресцентных профилей в программе GeneMapperTM, необходимо 

следовать инструкциям пользователя от производителя оборудования. 

Для корректной визуализации флуоресцентных меток COrDIS 

«ЭКСПЕРТ 26» необходимо проведение спектральной калибровки для набора 

красителей “CS6”, который должен быть создан пользователем в соответствии с 

пунктом 4.1 и откалиброван с использованием матрикс-стандарта CS6. 

 

 

4.1 Создание матрикса / спектральная калибровка 

 
Анализ продуктов амплификации COrDIS «ЭКСПЕРТ 26» на 

генетическом анализаторе возможен только после проведения калибровки с 6-ти 

цветным матрикс-стандартом CS6 (не поставляется с набором, заказывается 

отдельно по каталожному номеру CS6). Матрикс-стандарт содержит смесь 6-ти 

фрагментов разной длины, меченных разными флуоресцентными красителями. 

Эти красители использованы в наборе для мечения ПЦР-продуктов и размерного 

стандарта S550. 

Для приготовления рабочего раствора матрикс-стандарта CS6 добавить 

50 мкл деионизированной воды в пробирку, содержащую лиофилизированный 

CS6 и инкубировать при комнатной температуре 2 мин. Затем тщательно 

перемешать раствор на вортексе и собрать на дне пробирки коротким 

центрифугированием. Готовый раствор можно хранить в темном месте при 

температуре 2 °C – 8 °C до 2 недель. Для более длительного хранения раствор 

следует заморозить. Следует избегать повторного размораживания. 

При проведении спектральной калибровки настоятельно 

рекомендуется использовать только чистые септы, новый буферный раствор и 

воду. Использование ранее использованных септ при проведении спектральной 

калибровки может приводить к попаданию ранее исследованных меченных ПЦР 

продуктов в область анализа, и препятствовать успешному анализу матричного 

стандарта. 

 

Подготовка матрикс-стандарта для калибровки (ABI 3500 /8 капилляров) 

 

Hi-DiTM формамид  80 мкл 

Раствор CS6     8 мкл 

 

Добавить по 10 мкл смеси в лунки A01-H01 96-луночного планшета. 

При необходимости удалить пузыри со дна лунок центрифугированием. 
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Подготовка матрикс-стандарта для калибровки (ABI 3500XL/ 24 

капилляра) 

 

Hi-DiTM формамид  240 мкл 

Раствор CS6     24 мкл 

 

Добавить по 10 мкл смеси в лунки A01- H03 96-луночного планшета. 

При необходимости удалить пузыри со дна лунок центрифугированием. 

 

Спектральная калибровка 

 

Шаг А – Создание Dye Set для спектральной калибровки 

 

Перейти в раздел Library в программе Data Collection Software. 

В разделе Analyze выбрать вкладку Dye Sets. В открывшемся меню нажать 

кнопку Create (откроется диалоговое окно создания нового Dye Set). В 

появившемся окне указать параметры нового Dye Set: 

 

Dye Set Name   CS6 

Chemistry   Matrix standard 

Dye Set Template J6 Template 

Arrange Dyes  оставить без изменений 

Parameters: 

Matrix condition number  20 

Upper limit 

Minimal Quality Score  0.8 

 

 
 

Нажать кнопку Save. Новый Dye Set (CS6) появится в списке. 
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Шаг B – Проведение спектральной калибровки 

 

Перейти в раздел Maintenance в программе Data Collection Software. В 

разделе Calibrate, выбрать вкладку Spectral Calibration. В открывшемся окне 

выбрать количество лунок в используемом планшете (Number of Wells) и 

позицию планшета в приборе (Plate Position). В пункте Chemistry Standard 

выбрать Matrix standard. В пункте Dye Set выбрать CS6. Запустить процесс 

калибровки нажав кнопку Start Run. 

 

Шаг С – Оценка результатов спектральной калибровки 

 

После завершения работы прибора проверить статус каждого капилляра 

(pass или fail). Высота пиков должна быть не менее 2.000 rfu, но ниже 15.000 rfu 

(оптимальный диапазон между 5000 и 10000 rfu). 

Калибровка должна быть успешной минимум для 6 из 8 капилляров (или 

для 18 из 24 капилляров, соответственно). При использовании CS6 в качестве 

матриксного стандарта, в окне профиля калибровки (Intensity vs Pixel Number) 

должна отражаться следующая последовательность пиков. 

 

 

 

 

В случае успешной калибровки сохранить полученные результаты, нажав 

кнопку Accept. 
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4.2 Создание Instrument Protocol 

 

Перейти в раздел Library в программе Data Collection Software. 

В разделе Analyze, выбрать вкладку Instrument Protocols. В открывшемся меню 

нажать кнопку Create (откроется диалоговое окно создания нового Instrument 

Protocol). В появившемся окне указать параметры нового Instrument Protocol: 

 

Application Type   HID 

Dye Set     CS6 

Run Module  например “HID36_POP4” (выбрать протокол 

соответствующий параметрам системы) 

Protocol Name   EXPERT 26 
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Рекомендуемые параметры электрофореза для генетического анализатора ABI 

3500: 

 

Параметр  Значение 

Oven Temperature      60 

PreRun Voltage      15 

PreRun Time    180 

Injection Voltage     1.2 

Injection Time      10 

Data Delay Time        1 

Run Voltage   13.0 

Run Time  1600 

 

Нажать кнопку Save. 

 

В зависимости от состояния используемого прибора параметр Injection Time 

может быть скорректирован пользователем для достижения оптимальной 

амплитуды флуоресцентного сигнала (5–15  sec.).  Параметр Run Time также 

может быть скорректирован пользователем в случае, если рекомендуемое время 

фореза является избыточным (все фрагменты размерного стандарта 

детектируются существенно раньше отведенного времени) или недостаточным 

(не все фрагменты размерного стандарта детектируются за отведенное время). 

Оптимальное время фореза в наибольшей степени зависит от текущего состояния 

капилляров и полимера в генетическом анализаторе и может меняться со 

временем. 

 

4.3 Создание Size Standard 

 

Перейти в раздел Library в программе Data Collection Software.В 

разделе Analyze, выбрать вкладку Size Standards. В открывшемся меню нажать 

кнопку Create (откроется диалоговое окно создания нового Size Standard). В 

появившемся окне указать параметры нового Size Standard. Стандарт длины 

S550 содержит 26 фрагментов ДНК разной длины (н.п.): 60, 70, 80, 90, 100, 120, 

140, 160, 180, 200, 220, 230, 240, 260, 280, 300, 320, 340, 360, 380, 400, 420, 440, 

450, 500, 550. 

 

Нажать кнопку Save. 
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4.4 Создание QC Protocol 

 

Перейти в раздел Library в программе Data Collection Software. 

В разделе Analyze, выбрать вкладку QC Protocols. В открывшемся меню нажать 

кнопку Create (откроется диалоговое окно создания нового QC Protocol). В 

появившемся окне указать параметры нового QC Protocol: 
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Нажать кнопку Save. 



COrDIS «ЭКСПЕРТ 26»                  Инструкция пользователя        231110 

- 20 - 

 

 

4.5 Создание Assay 

 

Перейти в раздел Library в программе Data Collection Software. 

В разделе Manage, выбрать вкладку Assays. В открывшемся меню нажать кнопку 

Create (откроется диалоговое окно создания нового Assay). В появившемся окне 

указать параметры нового Assay: 

 

Assay Name    EXPERT 26 

Application Type  HID 

Instrument Protocol  EXPERT 26 

 

 
 

Нажать кнопку Save. 

 

4.6 Подготовка и загрузка продуктов амплификации 

 

Для загрузки образцов в прибор необходимо приготовить смесь Hi-DiTM 

формамида и размерного стандарта S550 в следующем соотношении: 

 

Компонент    Объем на один образец 

Hi-DiTM формамид  10.0 мкл 

Размерный стандарт S550 1 мкл 
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При расчете объемов компонентов смеси следует учесть, что 

формамидом должны быть заполнены все лунки, в которых будет происходить 

инжекция, в том числе и лунки, не содержащие образцы. Как минимум одна лунка 

при анализе каждой серии образцов должна содержать аллельную лестницу. 

После перемешивания добавить по 10 мкл смеси в каждую лунку 

планшета. Затем внести в лунки по 1 мкл ПЦР-продукта или аллельной лестницы. 

При необходимости удалить пузыри со дна лунок планшета коротким 

центрифугированием.  

 

Накрыть планшет резиновым ковриком и провести температурную 

денатурацию по схеме: 

__________ 
95°C 2 мин 

4°C _ 1 мин 
 

Загрузить планшет с денатурированными образцами в прибор в 

соответствии с инструкцией пользователя ABI PRISM® Genetic Analyzer. 

 

В состав набора входит аллельная лестница, рассчитанная на проведение 50 

инжекций (при нанесении 1 мкл аллельной лестницы в лунку планшета). При 

недостаточной чувствительности генетического анализатора допускается 

увеличение объема вносимой в лунку аллельной лестницы до 2 мкл. 

Размерный стандарт S550 рассчитан на 240 инжекций. При 

необходимости, объем вносимого в лунку размерного стандарта S550 может быть 

снижен до 0.3 мкл для увеличения возможного количества инжекций. Благодаря 

высокой плотности фрагментов стандарта S550 обеспечивается высокая точность 

и воспроизводимость определения длины амплифицированных фрагментов 

исследуемого образца без потери качества анализа. 

 

При проведении реакции амплификации в объеме 10 мкл (при 

исследовании образцов сравнения) один набор реагентов COrDIS «ЭКСПЕРТ 26» 

позволяет провести исследование 500 образцов. 

 

 

4.7 Запуск прибора 

 

Шаг A – Создание планшета 

 

Перед началом анализа необходимо создать Plate (планшет), 

описывающий расположение образцов на планшете и содержащий инструкции 

для прибора. Для этого необходимо перейти в меню Create New Plate 

программы Data Collection Software. Появится диалоговое окно, в котором 

необходимо указать параметры нового планшета. 
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Нажать кнопку OK. Появится новая таблица со схемой исследуемого планшета. 

 

 

Шаг B – Заполнение таблицы 

 

Для всех анализируемых лунок планшета необходимо указать: 

Sample name   имя объекта 

Sample type   тип образца 

Assay     EXPERT 26 

Filename convention  структура имени файла 

Results group   параметры сохранения файлов 

 

Шаг C – Запуск прибора и информация о статусе прибора 

 

После создания схемы расположения образцов на планшете, нажмите на 

кнопку Link Plate for Run. В открывшемся окне указать положение планшета в 

приборе и запустить электрофорез нажатием кнопки Start Run. 

 

 

5. ЭЛЕКТРОФОРЕЗ НА АНАЛИЗАТОРЕ «НАНОФОР 05»  

 

При работе с генетическим анализатором Нанофор 05 и последующем 

анализе флуоресцентных профилей в программе GeneMarker HID, необходимо 

следовать инструкциям пользователя от производителя оборудования. 

Для корректной визуализации флуоресцентных меток COrDIS 

«ЭКСПЕРТ 26» необходимо проведение спектральной калибровки для набора 

красителей “CS6”, который должен быть создан пользователем в соответствии с 

пунктом 5.1 и откалиброван с использованием матрикс-стандарта CS6. 

 

5.1 Спектральная калибровка 

 
Анализ продуктов амплификации COrDIS «ЭКСПЕРТ 26» на 

генетическом анализаторе возможен только после проведения калибровки с 6-ти 

цветным матрикс-стандартом CS6 (не поставляется с набором, заказывается 

отдельно по каталожному номеру CS6). Матрикс-стандарт содержит смесь 6-ти 

фрагментов разной длины, меченных разными флуоресцентными красителями. 

Эти красители использованы в наборе для мечения ПЦР-продуктов и размерного 

стандарта S550. 

Для приготовления рабочего раствора матрикс-стандарта CS6 добавить 

50 мкл деионизированной воды в пробирку, содержащую лиофилизированный 

CS6 и инкубировать при комнатной температуре 2 мин. Затем тщательно 

перемешать раствор на вортексе и собрать на дне пробирки коротким 

центрифугированием. Готовый раствор можно хранить в темном месте при 

температуре 2 °C – 8 °C до 2 недель. Для более длительного хранения раствор 

следует заморозить. Следует избегать повторного размораживания. 
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Перед проведением спектральной калибровки: 

1. Приготовьте 50 мл свежего ТАПС буфера однократного разведения. Для 

этого смешайте 45 мл деионизованной воды и 5 мл 10-кратного ТАПС 

буфера. Смесь перемешивать переворачиванием не менее 30 раз. 

2. Промойте деионизованной водой контейнеры для воды, слива и 

катодного буфера. 

3. Смените септы контейнеров для воды, слива и катодного буфера. 

4. При замене катодного буфера также всегда заменяйте анодный буфер 

(также при замене анодного буфера всегда заменяйте катодный буфер). 

Катодный и анодный буферы должны быть разлиты из одного и того же 

разведения 1х ТАПС буфера. 

5. Залейте свежий буфер в контейнеры для катодного и анодного буфера, 

деионизованную воду – в контейнеры для воды и для слива. 

 

Подготовка матрикс-стандарта для калибровки  

 

Hi-Di  формамид  80 мкл 

Раствор CS6     8 мкл 

 

Добавить по 10 мкл смеси в лунки A-H 96-луночного планшета. 

При необходимости удалить пузыри со дна лунок центрифугированием. 

 

Спектральная калибровка 

 

В главном окне программы НАНОФОР 05 в пункте меню Сервис выбрать 

опцию Спектральная калибровка. 

 

 
 

Появится окно Выбор ряда спектрального калибратора. 
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При нажатии кнопки Далее появляется окно Спектральная калибровка.  

В выпадающем списке нужно выбрать Модуль управления:   

 

Gordiz-CS_Spectr_PDMA4_36 

 

При необходимости в Модуле управления можно изменить параметры 

выбранной программы и сохранить его, либо оставить программу без 

изменений. 

 

Из выпадающего списка Набор красителей выберите Gordiz-CS6.  
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Появится окно Спектральная калибровка. Нажмите Принять. 

 

 
 

Нажмите ОК, чтобы перейти к запуску Спектральной калибровки: 
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Для запуска спектральной калибровки в меню главного окна программы 

НАНОФОР 05 нажать кнопку  Запустить или в пункте меню Действия 

выбрать опцию Запустить. 

 

 

 

 

После завершения программы измерений данные анализируются автоматически. 

В результате открывается окно Набор красителей с рассчитанными оценками 

качества спектральной калибровки по каждому капилляру. Возможны три 

варианта оценки качества: Хорошее, Удовлетворительное и Плохое. В 

последнем случае калибровку рекомендуется переставить.  

Если качество спектральной калибровки для всех капилляров Хорошее 

(допускается для одного капилляра – Удовлетворительно), нажать кнопку 

Принять. Калибровка сохранится под заданным в строке Набор названием и со 

временем ее проведения в формате год.месяц.число час.минута начала 

калибровки. 

 

 



COrDIS «ЭКСПЕРТ 26»                  Инструкция пользователя        231110 

- 27 - 

 

 

 

Типичный вид данных после применения матриц: 
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5.2 Подготовка и загрузка продуктов амплификации 

 

Для загрузки образцов в прибор необходимо приготовить смесь Hi-Di формамида 

и размерного стандарта S550 в следующем соотношении: 

 

Компонент    Объем на один образец 

Hi-Di  формамид  10.0 мкл 

Размерный стандарт S550 1 мкл 

 

При расчете объемов компонентов смеси следует учесть, что 

формамидом должны быть заполнены все лунки, в которых будет происходить 

инжекция, в том числе и лунки, не содержащие образцы. Как минимум одна лунка 

при анализе каждой серии образцов должна содержать аллельную лестницу. 

После перемешивания добавить по 10 мкл смеси в каждую лунку 

планшета. Затем внести в лунки по 1 мкл ПЦР-продукта или аллельной лестницы. 

При необходимости удалить пузыри со дна лунок планшета коротким 

центрифугированием.  

 

Накрыть планшет резиновым ковриком и провести температурную 

денатурацию по схеме: 

____________ 

95°C 2 мин 

4°C ___1 мин 
 

Загрузить планшет с денатурированными образцами в прибор в 

соответствии с инструкцией пользователя от производителя оборудования. 

 

В состав набора входит аллельная лестница, рассчитанная на проведение 50 

инжекций (при нанесении 1 мкл аллельной лестницы в лунку планшета). При 

недостаточной чувствительности генетического анализатора допускается 

увеличение объема вносимой в лунку аллельной лестницы до 2 мкл. 

Размерный стандарт S550 рассчитан на 240 инжекций. При 

необходимости, объем вносимого в лунку размерного стандарта S550 может быть 

снижен до 0.6 мкл для увеличения возможного количества инжекций. Благодаря 

высокой плотности фрагментов стандарта S550 обеспечивается высокая точность 

и воспроизводимость определения длины амплифицированных фрагментов 

исследуемого образца без потери качества анализа. 

Дополнительный размерный стандарт S550 может быть заказан по 

каталожному номеру S550-10. 

 

 



COrDIS «ЭКСПЕРТ 26»                  Инструкция пользователя        231110 

- 29 - 

 

 

5.3 Создание проекта 

 
Для создания нового проекта в главном окне программы НАНОФОР 05 в пункте 

меню Проект выбрать опцию Создать. В открывшемся окне Свойства проекта 

ввести имя оператора, название проекта. Убедиться в соответствии типа 

Пластика – Стрип / Планшет. При необходимости выбрать верный варианты 

типа пластика. Нажать кнопку Принять.  

   

 

 

 

Откроется главное окно Описание проекта.  
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Внести информацию об образцах: заполнить названия образцов и задать 

Программу Анализа (ПА). 

 

На поле ПА нужного ряда нажать на левую кнопку мыши два раза. 

Откроется окно Программа анализа.  

 

В графе Тип анализа выбрать: Фрагментный  

В графе Модуль управления открыть выпадающий список. Выбрать 

HID_600_PDMA4_36 

В графе Набор красителей выбрать Gordiz-CS6. 
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Нажать кнопку Принять. Откроется окно Описание проекта, вкладка 

Планшет, с заданной Программой анализа.  
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Нажать кнопку Принять. Откроется главное окно программы НАНОФОР 05 и в 

графе Статус в выбранном ряду проекта появится надпись Готов к анализу. 
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5.4 Запуск анализа проекта 

Для запуска анализа, после описания всех загруженных образцами рядов проекта, 

в меню главного окна программы НАНОФОР 05 нажать кнопку  Запустить 

или в пункте меню Действия выбрать опцию Запустить.  

Появится окно Свойства проекта. 

 

В открывшемся окне Свойства проекта ввести/изменить имя оператора, 

название проекта, при необходимости – указать путь сохранения дополнительной 

копии данных (если дополнительная копия данных не нужна – это поле 

оставляется пустым). Убедиться в соответствии типа Пластика – Стрип / 

Планшет. При необходимости выбрать верный вариант типа пластика. 
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Нажать Принять. Активируется главное окно программы НАНОФОР 05. Первый 

анализируемый ряд проекта выделится зеленым цветом, а в графе статус появится 

надпись Измерение.  

В нижней части окна рядом с надписью Лазер серый индикатор должен стать 

красным — это означает, что лазер включен.  

В конце строки Текущая отобразится время до конца текущего анализа, а в конце 

строки Все — время до конца анализа всех рядов проекта.    

 

В зависимости от состояния используемого прибора параметр Время ввода 

пробы  может быть скорректирован пользователем для достижения оптимальной 

амплитуды флуоресцентного сигнала (5–15  sec.).  Параметр Время 

электрофореза также может быть скорректирован пользователем в случае, если 

рекомендуемое время фореза является избыточным (все фрагменты размерного 

стандарта детектируются существенно раньше отведенного времени) или 

недостаточным (не все фрагменты размерного стандарта детектируются за 

отведенное время). Оптимальное время фореза в наибольшей степени зависит от 

текущего состояния капилляров и полимера в генетическом анализаторе и может 

меняться со временем. 

 

 

6. АНАЛИЗ ДАННЫХ 

 

6.1 Настройка программного обеспечения GeneMapper 

 

Полученные данные могут быть проанализированы с использованием 

программного обеспечения GeneMapper ID и GeneMapper ID-X. 

Программное обеспечение GeneMapper требует предварительной 

настройки параметров анализа. Параметры анализа для наборов COrDIS могут 

быть импортированы в программу из файлов настроек, предоставляемых 

производителем по запросу. 

Для анализа результатов электрофореза с использованием программного 

обеспечения GeneMapper необходимо произвести следующие действия: 

 

 

1) Произвести импорт файлов панелей и бинов 

Выбрать пункт меню Tools->Panel Manager. 
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В левом верхнем сегменте открывшегося окна установить курсор на позицию 

Panel Manager. 

 

 
 

 

Затем в меню выбрать File->Import panels. 
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В открывшемся окне найти и выбрать файл с панелями (например, файл EXPERT 

26-SRY). Загрузить нажатием кнопки Import.  

 

 
 

 

В левом верхнем сегменте окна выбрать загруженную панель (Например, 

EXPERT 26), затем в меню выбрать File->Import bin set. В открывшемся окне 

найти и выбрать файл с бинами (Например, файл EXPERT 26_bins). Загрузить 

нажатием кнопки Import. Нажать кнопки Apply и OK. 
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2) Произвести импорт настроек размерного стандарта 

 

Выбрать пункт меню Tools > GeneMapper Manager.  

 

 
 

В открывшемся окне выбрать вкладку Size Standards. 

 

 
 

Загрузить файл настроек размерного стандарта нажатием кнопки Import. Нажать 

кнопку Done. 

 

3) Создать новый метод анализа 

Выбрать пункт меню Tools -> GeneMapper Manager.  

открывшемся окне выбрать вкладку Analysis Methods.  

Нажать кнопку Import и загрузить файл настроек Метода Анализа. Нажать 

кнопку Done. Сохранить изменения. 
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6.2 Cтандарт длины S550 

 

Ниже приводится пример электрофореграммы с сигналами фрагментов 

стандарта S550 в канале детекции Orange. Обозначения 26 фрагментов ДНК 

приводятся в соответствии с их размером: 60, 70, 80, 90, 100, 120, 140, 160, 180, 

200, 220, 230, 240, 260, 280, 300, 320, 340, 360, 380, 400, 420, 440, 450, 500, 550.  

 

 
Рисунок 1. Электрофореграмма размерного стандарта S550. Размеры фрагментов.  
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6.3 Диапазоны размеров аллелей исследуемых локусов 

 

Локус 
Аллели 
MK01 

Канал детекции 
Диапазон длин 
фрагментов 

Диапазон аллелей 

Amelogenin X X синий 81 X 
Amelogenin Y Y синий 84 Y 
SRY SRY синий 89 SRY 
D3S1358 15,17 синий 93-148 11- 20 
TH01 6,9.3 синий 152-197 4-13.3 
D12S391 21,23 синий 203-267 15-26 
D5S818 9,12 синий 269-325 6-15 
TPOX 8,9 синий 327-379 6-13 
Yindel 2 зеленый 78-87 1-2 
D2S441 14 зеленый 93-133 8-16 
D7S820 10,12 зеленый 137-185 5-14 
D13S317 11 зеленый 186-240 7-16 
FGA 20,22.2 зеленый 240-399 16-45.2 
D22S1045 15 желтый 82-127 10-19 
D18S51 14,16 желтый 127-213 7-27 
D16S539 12,13 желтый 213.4-260 8-15 
D8S1179 10 желтый 260-318 8-17 
CSF1PO 9,11 желтый 320-370 8-15 
D6S1043 11 желтый 375-454 10-21.3 
vWA 16,18 красный 85-157 8-22 
D21S11 30.2 красный 158-227 23.2-37 
SE33 24.2,29.2 красный 227-385 4.2-43 
D10S1248 15 фиолетовый 90-145 10-17 
D1S1656 14,17.3 фиолетовый 170-227 10-20.3 
D19S433 13,15 фиолетовый 228-286 11-16.2 
D2S1338 17,21 фиолетовый 289-367 15-27 
DYS391 10 фиолетовый 380-435 5-16 
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6.4 Амплификация контрольной   ДНК 

 

 

 

Рисунок 2 Результата анализа Контрольной ДНК MK01. 
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6.5 Аллельная лестница 

 
 

 

Рисунок 3. Аллельная лестница COrDIS «ЭКСПЕРТ 26».  
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